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TradeStation Interface via email notification

OEC Trader captures TradeStation signals and parses the email notifications coming from TradeStation.
OEC Trader supports all type of email strategy notification; all types of orders (market, limit and stop);
optional manual confirmation; symbol mapping; advanced account assignment; redirection email
notification to user’s email client. In order for signals to be captured from TradeStation the local SMTP
port cannot be busy. Moreover, only one OEC Trader on the computer can capture signals.

TradeStation and OEC Trader Settings

System requirements
1. If using Windows Professional or above, please be sure that Windows SMTP service is disabled.

2. Open the Control Panel from Windows Start menu and go to the Administrative Tools > Services
application. Disable the Windows SMTP service, if it is installed and started: use a right click to
open “Properties” of this service. Change “Startup type” to “Disabled” and press “Stop” and OK.

3. If you use an SMTP service of another provider, please stop this service or re-configure it to not
use 25 port.

4. Be sure to close all other TradeStation capture applications. These applications use port 25 too.
5. Check your firewall settings. The SMTP port should not be prohibited for local use.
6. Only one instance of OEC Trader can capture TradeStation signals at one.

TradeStation
1. Open the TraderManager Tools in TradeStation

2. Open the TraderManager Preferences via View in main menu of TradeStation.
3. Set email notification for Strategy Active, Canceled, Filled and Replaced Order
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4. Check “Enable e-mail notification” and press “Configure..”.

-

TradeManager Preferences

General | Motification |

Order Statuz Matifization Type
Feplace Order [A]
ay Active Order
Strateqy Canceled Order B
Strategy Filled Qrder B

'B’tfatg_gg_Heplaced Order
I:ule e-mail notification  {f Corfigure..

i Configure... |

[] Enable window notification

[[] Enable gound notification

[ 0. H Cancel H Help l

5. Inthe message dialog box enter any address for the “From email address” field, your email

address to “To” field and “LOCALHOST” or “127.0.01” in “SMTP Server name” field.
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Messaging

=,

From

Ermail addrezs

autox(Sopenecry.com
To

Email addrezzes: [ j.zmithi@email. com;j. doe@email.com)

rvinicky@openecy.com

Uzing

Si'ii i ||I|I ,..- Ir IP address:

[] My SMTP Server requires authentication

Pas war

Settings
{#) Standard Email Format
{7 Short Message Service Format

M asirmurn number of characters per email: | B4000

SMTP Lookup...

0K,

]

Cancel l [ Help

OEC Trader
1. From the main menu of OEC Trader open File > AutoX Capture > Capture Settings
File Account  Orders Communications Quotes View Reports 4
Logoff Buy Price | #S5cld | Awg. Sell Price | MNetPos| 5T
Export Settings
Import Settings
Allow DDE
| AutoX Capture » | Capture Activated
Exit |g Capture Settings... |
: Extension Enabled
Account | Order# | State : @3:'11"’& Settings...
) Lo
Queued Orders

he TradeStation messages to your email

2. Fill out the “From” field with the same email address in TradeStation Messaging.
3. Check “Redirect emails to:” box, if you want to redirect t

client.
4. Check “Enabled” and press OK
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E AutoX Capture Settings

General
Enabled [ Manual Corfimation

) Send market order on Filled report frecommended)
() Send signals A5S-S5
{(#) Send AS-IS, but convert to market order on Filled report
if arder has not filled during
Dont use MARKET for eCBOT

1015 secs

Desynchronization Timeout: 35135 SECS

TradeStation’s Messaging SMTP Settings

From: |autcx@openecry.com

Redirect emails to:

Host: | SERVERMAME Port: 25
[] Use Authertication
Lser: Pwd:

Send emor and connection notifications ta:

rvinicky @openecry.com Test

Install TS Extension Extension Enabled

Mapping
Simple Exiended
Workspace | TS Symbol | Interval | Account | OEC Symbol | F
| <Ay <Ay <Any= 10598 |
& d B
Add ] [ Edit ] [ Remaove
Symbols: default
. 5 QEC Continuous | Multiplier | Description .
| 6A BA 1 Aussie Dollar '
BAL BAH 1 Aus Dollar Cal 5
BAJGC) BA(GC) 1 Can/fus Dollar
BA(EN) GA(GN) 1 New Zealand/A
6B EB 1 Brtish Pound
BBH EBH 1 Brtish Pound Cz
BC BC 1 Canadian Dollar |
6CH GCH 1 Canadian Dollar| |
(il m | i
[ ShowDefaut |{ Add |
[ ok || Cancel

Other options

e Enabled: Start capturing TradeStation signals

e Manual Confirmation: Asks for user a confirmation on all TradeStation reports. User can review
corresponding order and send, modify or cancel, decline report and corresponding action, or
allow it to execute corresponding action immediately.

e Send mode options manage how and when an OEC order will be sent depending on state of

related TradeStation Strategy Order.

0 Send market order on Filled report. A market order will be sent, when a TradeStation
Strategy order is filled. All other types from TradeStation reports are ignored and
skipped. If the order is cancelled, no actions are performed at all. This option ensures
the most accurate synchronization of positions (during this process, if positions are

synchronized initially)

0 Send signals AS-IS. OEC Trader sends an order that is identical to the TradeStation
Strategy order description, except short order side (“sell short” treats as “sell”, “buy to
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cover” treats as “buy”). Because TradeStation Strategy orders and OEC Trader orders are
filled in different environments the TradeStation Strategy and OEC Trader positions
could become unsynchronized.

0 Send AS-IS, but convert to market on Filled report. The same as previous option, but a
conditional order will be modified to a market order on a Filled report from
TradeStation, if an OEC Trader order is not filled in selected timeout.

- Don't use Market for eCBOT. Currently OEC Trader does not support modify
requests from Stop/Limit/Stop-Limit to a Market order for eCBOT contracts. So,
all modify requests on Filled Report for eCBOT contracts will be rejected. As a
workaround, this option allows us to simulate market orders via opposite a
order type. Example: A Stop order will be modified to Limit order with the same
price and vice versa.

- Desynchronization Timeout displays an alert, if the OEC Trader order has been
filled, but the TradeStation Strategy order is still working (no incoming Filled
report for this order).

Note: To decrease desynchronization of positions a market order will be sent on a Filled report from
TradeStation in the case of a “Send signals AS-IS”. If the original order is rejected and the reason is
related to trigger price the reason will contain “trigger price”.

Messages and Notifications

It is possible to redirect all incoming messages to 3™ party SMTP-enabled software, including 3™ party
email services. Note: The 3™ party email service may require authentication. The user will need to find
out this information from their provider and fill out the host, port and authentication fields of Redirect
group box to enable this feature. OEC Trader can send connection status and internal error notifications
through the selected redirect point and deliver to the selected email addresses. Moreover, it is possible
to send SMS to cell phones. The user can simply type his cell phone number in the “Send error and
connection notifications to:” field.

SMS Examples

Alltel 6505551111 @alltelmessage.com
AT&T, formerly Cingular | 16505551111@mobile.mycingular.com or 6505551111@mobile.att.net
(Not sure which format to use? Contact AT&T for more information)

Rogers Wireless 6505551111@pcs.rogers.com

Sprint PCS 6505551111@messaging.sprintpcs.com
T-Mobile 6505551111 @t-mobile.net

Telus Mobility 6505551111@msg.telus.com

Verizon Wireless 6505551111@vtext.com
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Messages and Notifications Limitations - OEC Trader supports only regular SMTP connections. Secured
connections like TLS (Transport Layer Security) and STARTTLS (as required by GMail, for example) are
not supported.

Mapping
There are two modes of mapping: Simple and Extended. Simple mapping has two maps: one maps the

workspace name to account and the other maps the symbols. Symbol map is assigned to workspace.
Default symbol map is used for references only.

e Account Assignment group box maps the workspace name of the incoming signals to an OEC
Trader account. The signals from non-defined workspaces are ignored. One workspace can map
to one account.

e Symbol Mapping: Converts TradeStation symbol names and price scales to OEC Trader.
Additionally, it maps corresponding TradeStation continuous contract to specific OEC Trader
contract. Each workspace has its own mapping. If the symbol is not defined in the mapping, its
signals will be ignored. If there are no selected workspaces the Symbol Mapping will show
default mapping. The settings from this mapping are used at the time of workspace-related
mapping editing.

i Mapping 1
T5: ES
OEC: ES v
(E 3 ESUT E4
Fultiplier: 1%
]9 ] [ Cancel

Extended mode uses the incoming workspace name, TradeStation symbol and the interval to map to the
OEC Trader account and contract.

I apping

Simple | £ Extended

Workzpace | TS5 Symbal | Interval | Account | OEC Symbol | Price Mult. | Gty Mult

<Ay @ERZ <y YICO2 ER2U7 1 1

<hnys ES by YICO ESU7 4 2

OECTEST Al ARy VICOT ' 1 2
Add
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The above mapping says:

1. “@ER2 TradeStation symbol from any workspace and any interval chart should be treated as
ER2U7 contract and processed through VIC02 account”

2. “any ES TradeStation symbol from any workspace and any interval chart should be treated as
ESU7 contract, processed through VICO1 account with price multiplier = 4 and quantity
multiplier = 2”

3. “all YM TradeStation symbols from workspace OECTEST and any interval chart should be treated
as corresponding YM contract by default symbol mapping rule (e.g., YMMOQ7 => YMM7),
processed through VICO1 account with quantity multiplier = 2”

User can add and edit these mapping via the AutoX Mapping dialog box (as seen below):

"a:] AutoX Mapping
Workspace: () Account; | TESTCME] v
© Ay
TradeStation Symbol: ()

() &y [default symbal map) Price tultiplier: 1

Interwal: ) Ly i gher 2:
© Ay

Ok ] [ Cancel

This dialog show the rule that accepts all signals and routes to TESTCME account with quantity multiplier = 2

Extension

e Install TS Extension: This checks the installed version of the TradeStation extensions and
recommends installing the latest version if it is obsolete or missing. Please see OEC API
functionality inside EasylLanguage topic for details.

e Extension Enabled: Starts revealing OEC API functionality to TradeStation. If this check box is
unchecked TradeStation Extension has no access to the OEC API. Please see OEC API
functionality inside EasylLanguage topic for details.

Process
1. Insert any strategy in “Chart Analysis” in TradeStation. Be sure that the simulated mode is turned
on.
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3. Catch and confirm (if “Manual Confirmation” is checked) the signals from TradeStation in OEC Trader.
The signal name and interval of the base chart is located in comments of the OEC Trader order.

Completed Orders

Account

WIC
YT
YT
YT
YICo
WICo
WICo
WIC
YT
YIC
YT
YICo
WICOT

Order #

1337674
1337675
1337676
1337677
1337678
1337679
1337680
1337631
1337682
1337683
1337684
1337685
1337686

State

Campleted
Campleted
Campleted
Caompleted
Completed
Completed
Completed
Campleted
Campleted
Campleted
Completed
Completed
Completed

Side
Buy
Sell
Sell
Buy
Sell
Buy
Sell
Buy
Sell
Buy
Sell
Buy
Sell

409:54:36.056 #1337684 Create Sell 1 ERZM7 MKT

09:54:30.056 Sent

AL AL A PEn el - BT A

Oty
14
14
14
14
141
14
14
14
14
14
14

“AhALA T

Frice

MET FOE
MET FOK
MET
MET
MET FOE
MET FOE
MET
MET
MET
MET
MET
MET
MET
MET FOE

kAT COb’

Avg Price | Comments Time
12973 MA3CELE, 1 min. 035312103
12972 Customl:, 1 min. 0%:53:13.009
831.8  Profit Target, 1 min. 09.5317.025
831.8 KewRevLE. 1 min. 09:54:09.681
12963 CusztomSE [shart], T min. 03.54:10.916
12371  EbDIS* [to cover). 1 min. 09:54:14.103
831.3  Profit Target, 1 min. 09:54:15.634
8320 MomLE, 1 min. 035416572
831.8  Stop Lozz, 1 min. 09:54:17.134
8316 MewHi, 1 min. 09:54:34.447
831.7  Profit Target, 1 min. 09:54:36.056
831.8 PCHLE. 1 min. 03:54:36.931
831.¥  Stop Losz, 1 min. 09:54:37. 231
12968  MewHi, 1 min. 09:54:47 447
1007 Char | ;e 1 emiee N3-Fd4. 47 7RO
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A log of TradeStation interaction is stored to file and can be viewed inside the OEC Trader using the

AutoX Log window.

File -> AutoX Capture -> Log

o] AutoX Log g@
Timespan Level | Report Message TS Oider Order #| OEC Oider Conbract | Signal Interval | wo|s
11:47:52.592 Infa Starting
11:47.53093  Info Cancelled  Cancel sent Sell Short 1 rhMO7 @ 13483 Stop Market 1359053 Sell 1 YMM7 STP 13483 TMM? Mewlo 1 min, C:AF
11:47.54.343  Info Active Sent Sell Short 1YMMO7 @ Market 1359073 Sell 1 YMMT MET TMM? CustomSE 1 min, C:4F|
11:4755546  Info Active Sent Buy 1 YMMO7 (@ 13690 Stop Market 1359080 Buw 1 YMM7 STP 13690 TMM? MewHi 1 mir, LR
11:47:56.765 Infa Active Sent Buy to Cover 1 YMMOT7 & 13433 Stop Market 1359081 Buw 1 YMM7 STP 13493 YMM7 Stop Loss 1 mir. CAF
11:47.57.968 Info Active Sent Buy to Cover 1 YMMO7 & 13492 Limit 1359082 Buy 1 YMM7 LMT 13452 M7 Profit Target 1 mir. C:AH
11:47:58.6593 Info Possible desynchronization 1359082 Buy 1 YMM7 LMT 13452 b7
11:47:63.203 Info Filled Filled iz skipped because of market order Sell Short 1 vMMO7 @ Market rMO7 CustomSE 7 min CAF
11:48:00.437 Info Active Sent Sell Short 1 vMMO7 @ Market 1359083 Sell 1 vMM7 MKT Tt MaCross5E 1 e C:AF
11:48:01.640 Ermar Cancelled Not-working order. Completed Buy to Cover 1 YMMO7 @ 13492 Limit 1359022 Buy 1 YMMT LMT 13492 M7 Profit Target 1 min. CA\F
11:48:02.859 Infa Filled Conwert to market-onefilled in 10 secs Buy to Cover 1 YMMOT7 @ 13493 Stop Market 1359081 Buw1YMM7 STP 13493 M7 Stop Loss 1 min. ChF
11:48:04.078 Infa Active Sent Buy to Cover 1 YMMOT @ 13493 Stop Market 1359084 Buy1YMM7 STP 13493 M7 Stop Loss 1 min. CHF
11:4805.312 Infa Active Sent Buy to Cover 1 YMMO7 @ 13432 Limit 1359085 Buw 1 YMM7 LMT 13492 YMM7 Profit Target 1 mir. CAF
11:48:05.703 Infa Possible desynchrorization 1359085 Buy 1 YMM7 LMT 13492 M7
11:48:06.500 Info Filled Filled is skipped because of market order Sell Short 1 YMMO7 & Market rMO7 MéCross5E 1 min. CAF
11:48:07.750 Info Active Sent Sell Short 1 vMMO7 & Market 1353086 Sell 1'YMM7 MKT b7 M3CrsSE 1 min. C:AF
11:48:08.953 Ermor Cancelled Noreworking order: Completed Buy to Cower 1 MMO7 & 13432 Limit 1359085  Buy 1 YHM7 LMT 13452 b7 Profit Target 1 min, CAR
11:48:10.156 Infar Filled Convert to market-ondfiled in 10 secs Buy to Caver 1 YMMO7 & 13433 Stop Market 1358081 Buy 1 YMM7? STF 13493 ThM7? Stop Loss 1 mik. C:AF
11:48:11.296 Infa Active Sent Buy to Cover 1 YMMO7 @ 13493 Stop Market 1359027 Buw1'YMM7 STP 13493 M7 Stop Loss 1 min. CA\F
11:48:12.500 Infa Active Sent Buy to Cover 1 YMMO7 @ 13492 Limit 1359088 Buy 1 YMMT LMT 13492 M7 Prafit Target 1 min. CHF
11:48:12.859 Infa Market-on-Filled madify iz zent 1359081 Buy1YMM7 STP 13493 M7
11:48:12.875 Infa Possible desynchronization 1359088 Buw 1 YMM7 LMT 13492 M7
11:48:13.718 Info Filled Filled is skipped because of market order Sell Short 1 YMMO7 & Market rMO7 Mé3CrsSE 1 min. CAF
114814937 Info Active Sent Sell Short 1 7MMO7 & 13491 Stop Market 1359090 Sell 1YMM7 STP 13431 MM KIChSE 7 min, CAF
11:48:16.140 Emor Cancelled Noreworking order: Completed Buy to Cowver 1 rMMO7 @& 13432 Limit 1359088 Buy 1 YMM7 LMT 13452 7 Profit Target 1 min, CAF
11:48:17.265 Info Filled Corwert to market-ondfilled in 10 secs Buy to Cowver 1MMO7 @ 13433 Stop Market 1353084 Buy 1 YMM7 STP 13433 it Stop Loss 1 min, CAREL
TVACAORIE  lein Aok ot Dis b P e 100N COTANT (2% DA N Ch, bk el 17EGN91 Diw INNNNCOWAFETOOAN A COMT ChRLey 1 oo racl

>

@ Connected 11:49:06 AM .

Queued Messages
All TradeStation messages are queued in the case of a lost of connection to OEC Servers and pushed to

execution after a successful reconnection. In addition, OEC Trader pre-processes the queued messages

with following rules:

1.

If queue contains Active message and corresponding Cancel is incoming => no order will be sent

on reconnection.

If queue contains Active message and corresponding Replace is incoming => modified version of

order will be issued instead of original one

If queue contains Active or Replace message and corresponding Filled is incoming, market order

will be issued.

If queue contains two counter Active messages with equal quantity, workspace, interval and
symbol and both marked as “Send as MKT”, these orders will be removed from queue (“closed
by counter order)

A user can view the current queued messages via the File -> AutoX Capture -> Queued Orders dialog

box.
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E AutoX Queued Messages g@ R
# Timespah . Repart TS Order Syrmbal Signal Send Az MET | Interval workzpac
7B 11:49:23.828  Filled Sell Short 1 vMMO7 G M arket YMMO7 CustomSE 1 min. C:%Programr
7a 11:43:26.250 Cancelled Buy to Cover 1 MMO7 3 13487 Limit YMMO7 Prafit Target 1 min. C:%Programr
79 11:49:27 546 Filled Buy to Cover 1 MMO7 (22 13488 Stop Market YMMO7 Stop Losz 1 min. C:%Program
az2 11:43:31.109  Cancelled Sell Short 10 000 ER 2007 (22 839,20 Stop Market ER2MO7 FamSE 1 min. C:Program
a4 11:43:33531  Cancelled Buy 1 vhabd 07 (23 13690 Stop Market ik 07 MewHi 1 min. C:Program
94 11:49.45. 734 Active Buw 1 %'k 07 (22 13530 Stop Market Y07 MHewHi 1 min. C:\Program
108 11.80:02 687 Active Sell 1 MAMOT @& karket NOMO7 MaCrosslx Yo Daily C:\Program
296 11:53:50.906  Active Sell Short 10 000 ER 2M07 & 838 60 Stop Market ERZ2MO7 MHewlo 1 min. C:%Programr
323 11:54:23 609 Replaced Buy 1 HOMO? (=3 1318.00 Stop b arket HOMO? ParLE 100 Share Bar C:“Pragrar
434 11:56:38.062  Actve Buw to Cover 1 000 000 NOMOT (3 Market MHOMO? Entry Mame Daily C:\Pragrar
435 11:56:39.328  Active Buy 1 MOMO? (2 b arket MNOMO? Ertry Mame Daily C:%Prograr

(% I | >

@ Disconnected 11:56:40 AM

TradeStation Email format
Example of a new order email notification

TradeStation - Strategy Active Order for NQMO7

Order: Buy 1 NQMO7 @ 1834.00 Stop Market

Account:

Occurred: 4/13/2007 4:24:06 PM

Signal : NewHi

Interval: 1 min.

Workspace: C:\Program Files\TradeStation 8.2 (Build 3894)\MyWork\OECTEST

Example of a cancel request notification
TradeStation - Strategy Canceled Order for NQMO7

Order: Buy to Cover 1 NQMO7 @ 1834.00 Stop Market

Account:

Occurred: 4/13/2007 4:27:06 PM

Signal: NewHi

Interval: 1 min.

Workspace: C:\Program Files\TradeStation 8.2 (Build 3894)\MyWork\OECTEST

OEC API functionality inside EasyLanguage

General

Implemented in OEC Trader is a TradeStation extension that provides the full functionality of OEC API
inside TradeStation strategy scripts. The extension has 457 functions that reflect all objects, properties
and methods of OEC API. OEC API code is called from the extension indirectly. Actually the OEC APl is
hosted by OEC Trader and exposes OEC API functionality to TradeStation. The extension allows a
strategy to avoid the limitations of TradeStation. The TradeStation strategy will have access to OEC
Trader average positions, account balances, basic and advanced orders, handle failure situations, avoid
synchronization troubles, and etc. In other words, TradeStation + extension provide one more
programming environment that can be used by TradeStation-related programmers instead of .Net
environment. This extension can be used independently of the email notification capture feature (send
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orders through extension instead of TradeStation constructions) as well as together. A strategy could get
extension functions to obtain positions and balances, but use TradeStation construction to send orders.

Infrastructure

The scheme below shows the process boundary, inter-process communication via .NET remoting, and
data flow.

OEC Trader TradeStation

Some : Strategy

| |
b 1

OEC API Remoting provider Remoting consumer Extension ----
AN T
|
|
|
|
|

So by this scheme, OEC Trader shows all order manipulations real-time from the TradeStation’s strategy
and vice versa. The strategy can take into account user operations, real OEC Trader positions and prices.

Installation and Settings

Open AutoX Capture Settings dialog to find “Install TS Extension” and “Extension Enabled” at the bottom
left of the window.

Fwd:

([:_lnstallTS E stension ] [] Extension Enable
Installation

TradeStation Extension consists from of files (OecFuncs.dll and TSGateway.dll) and is installed to OEC
Trader folder at the time of the OEC Trader installation. At this time these files are placed on the users
computer, but not integrated into TradeStation. A user can install and integrate this extension to
TradeStation environment via the “Install TS Extension” button. The required files will be copied to
TradeStation folder. Now “Extension” and “Remoting consumer” components from scheme above are

installed and a user can export OEC functions from the extension and verify strategies.

Enabling

In spite of the components installed, the link between “Remoting provider” and “Remoting consumer” is
not established yet (see scheme above). “Extension enabled” option responds only when the Extensions
Enabled checkbox is selected.
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Error Processing
The TradeStation extension supports native TradeStation events and error processing mechanisms that

protects TradeStation from crashing. All exceptions are captured and shown in TradeStation Event
Manager.

OEC Extension Functions
All functions have the same pattern and use OEC APl name convention.

1. Selection of objects for further operations
oecSelectXXX(name of object);
oecSelectXXXByID(id of object);
oecSelectXXXBylIndex(index in collection)
where XXX is OEC APl object.
Sample:
* oecSelectAccount(“TEST001”) => select and use TEST0O01 in further operations

* oecSelectContractGroupBylndex(0) => select and use first contract group from collection of
groups

2. Access to OEC API data and methods

After object selection, strategy can read its data and call its methods. The pattern of getter functions
and methods is:

o0ecXXXYYYZZZ(parameters)
where XXX — name of OEC API object (optionally);
YYY — name of nested OEC API object (optionally)
ZZZ — name of OEC APl method or property.
Sample:
* oeclsCompleteConnected() => OEC.API.OECClient.Global. CompleteConnected

* oecAccountName() =>OEC.APIl.Account.Name. Account should be selected before by means of
any oecSelectAccount***() function.
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Example of strategy

This example code shows the use of different functions from different areas of the OEC Trader
TradeStation Extension (contract listing, average positions, sending orders ((simple, OCO, brackets)),
allocation block construction/usage, canceling and modifying).

{ Import external OEC APl functions }

External: "OecFuncs.dll', bool, "oeclsCompleteConnected";

External: "OecFuncs.dll', int, "oecAvgPositionNetVolume";

External: "OecFuncs.dll", double, '"oecAvgPositionNetPrice";

External: "OecFuncs.dll", bool, "oecSelectAccountBylndex", int{{Accountlindex}};
External: "OecFuncs.dll', bool, "oecSelectContract", LPSTR{{symbol}};

External: "OecFuncs.dll', LPSTR, "oecAvgPositionContract";

External: "OecFuncs.dll", double, *"oecAvgPositionGain';

External: "OecFuncs.dll", LPSTR, "oecAccount";

External: "OecFuncs.dll", void, "oecFreeze";

External: "OecFuncs.dll', void, "oecUnfreeze";

External: "OecFuncs.dll', bool, "oecSelectContractBylndex™, int{{Contractindex}};
External: "OecFuncs.dll", int, "oecContractsCount";

External: "OecFuncs.dll', LPSTR, "oecContractPositionSymbol";

External: "OecFuncs.dll', LPSTR, *oecContractName";

External: "OecFuncs.dll', LPSTR, "oecContract";

External: "OecFuncs.dll", LPSTR, "oecCreateDraft", LPSTR{{Side}}, int{{Qty}}, LPSTR{{Type}},
double{{Price}}, double{{Price2}}, LPSTR{{Flags}}, LPSTR{{Comments}};

External: "OecFuncs.dll', LPSTR, "oecSetDraftTime", LPSTR{{Draft}}, double{{Start}},
double{{End}};

External: "OecFuncs.dll", LPSTR, "oecCheckDraft', LPSTR{{Draft}};

External: "OecFuncs.dll', bool, "oecSendOrder', LPSTR{{Draft}};

External: "OecFuncs.dll', LPSTR, "oecSetDraftlceberg"”, LPSTR{{Draft}}, int{{Volume}};
External: "OecFuncs.dll", double, "oecCurrentPricelLastPrice";

External: "OecFuncs.dll", int, "oecOrdersCount";

External: "OecFuncs.dll', bool, "oeclsOrderlsFinalState";

External: "OecFuncs.dll', bool, *"oecCancelOrder";

External: "OecFuncs.dll", int, "oecOrder";

External: "OecFuncs.dll", bool, "oecSelectOrderBylndex", int{{OrderlIndex}};

External: "OecFuncs.dll', bool, "oecSendOCO", LPSTR{{Draftl}}, LPSTR{{Draft2}};
External: "OecFuncs.dll', bool, "oecSendLinked2", LPSTR{{MainDraft}}, LPSTR{{LinkedDraftl}},
LPSTR{{LinkedDraft2}};

External: "OecFuncs.dll', bool, "oecSelectAvgPositionBylndex", int{{AvgPositionlndex}};
External: "OecFuncs.dll", int, "oecAvgPositionsCount";

External: "OecFuncs.dll", LPSTR, "oecAvgPositionPositionContract";

External: "OecFuncs.dll', double, *"oecTotalBalanceNetLiquidatingValue;

External: "OecFuncs.dll', LPSTR, "oecContractType";

External: "OecFuncs.dll", void, "oeclnitializeAllocationBlock", LPSTR{Name}, LPSTR{Rule},
LPSTR{AccountLotsList};

External: "OecFuncs.dll', int, "oecAccountsCount";

External: "OecFuncs.dll', LPSTR, "oecAccountCH";

External: "OecFuncs.dll', LPSTR, "oecAccountType";

External: "OecFuncs.dll", LPSTR, "oecAccountTrader";

External: "OecFuncs.dll', bool, "oecModify", int{Quantity}, LPSTR{Type}, double{Price},
double{Price2};

External: "OecFuncs.dll', int, "oecOrderQuantity";

External: "OecFuncs.dll', LPSTR, "oecOrderType";

External: "OecFuncs.dll', int, "OnCreateProc", IEasylLanguageObject;
External: "OecFuncs.dll", int, "OnDestroyProc", IEasylLanguageObject;
#Events

OnCreate = OnCreateProc;

OnDestroy = OnDestroyProc;
#End;

variables: counter(0), qty(0), price(0.0), draft(""), draft2('""), draft3('""), AB('""), ABSize(0);

if LastBarOnChart then
begin
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{ Freeze OEC Trader and OEC APl data during strategy body calculations }
oecFreeze();

{ Check connection status of OEC Trader }
if oeclsCompleteConnected() then

begin

AB = ";

ABSize = 0O;

qty = 0;

{ Select and use ESM7 hereinafter }

oecSelectContract(*'ESM7'");

for counter = 0 to oecAccountsCount() - 1

begin
oecSelectAccountBylndex(counter);
Print(oecAccount(), ', ", oecAccountCH(), ", ', oecAccountType(), ", ",

oecAccountTrader());

it oecAccountCH() = "RJO" and oecAccountType() = "Customer™ and
oecAccountTrader() = "vic" then begin
if AB <> ' then
AB = AB + ",";
AB = AB + oecAccount() + "=1";
ABSize = ABSize + 1;
qty = qty + oecAvgPositionNetVolume();

end;
end;
Print("AB: ", AB, ', Size: ', ABSize, '; sum pos: ", qty);
if qty < O then

ABSize = - ABSize;

{ Use first account }
oecSelectAccountBylndex(0);

{ list and prints all available contracts }
For counter = 0 To oecContractsCount()-1 Begin
oecSelectContractBylndex(counter);
Print(oecContract(), ": ", oecContractName(), " ', oecContractType());
end;

for counter = 0 to oecAvgPositionsCount()-1

begin
oecSelectAvgPositionBylndex(counter);
Print(""Position: ", oecAvgPositionPositionContract(),
*; Volume:", oecAvgPositionNetVolume():10,
"; Avg.Price:", oecAvgPositionNetPrice():10,
'"; Gain: ', oecAvgPositionGain());
end;
Print(*"Net Liq. Value: ", oecTotalBalanceNetLiquidatingValue():10:2);

{ Select and use ESM7 hereinafter }
oecSelectContract(*"ESM7'");

{ Print ESM7 average position }
qty = oecAvgPositionNetVolume();
price = oecAvgPositionNetPrice();
Print(*'Selected ESM7'");
Print(*'Net Volume:", qty,
"; Avg.Price:", price,
"; Contract: ", oecAvgPositionContract(),
", Account: ', oecAccount(),
'; Gain: ', oecAvgPositionGain());

{ Cancel all working orders }

for counter=0 to oecOrdersCount()-1 Begin
oecSelectOrderBylIndex(counter);
if oeclsOrderlsFinalState() = false then
begin
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if oecOrderType() = "Limit" then
oecModify(oecOrderQuantity() * 2, ", 0, 0);
if(oecCancelOrder()) then
Print(**Canceling order #", oecOrder());
end;
end;

end;

{ Unfreeze OEC Trader and APl and use local variables hereinafter }
oecUnfreeze();

if oeclsCompleteConnected() then
begin
if qty > 0 then
draft = "Sell”
else
draft = "Buy";

{ Create order draft. draft is a string variable with description of order }
draft = oecCreateDraft(draft, 2 * AbsVvValue(qty), "lceberg",
(oecCurrentPriceLastPrice() + price)/2, 0, "None'", "Reverse By TS™);

{ Set Start time. End time stays default }
draft = oecSetDraftTime(draft, ComputerDateTime() + 1, 0);

{ Set Iceberg data. Volume = 1 }
draft = oecSetDraftlceberg(draft, 1);
Print(draft);

{ Check draft data. oecCheckDraft should return empty string or invalid parts of
order }
Print("Invalid parts: ", oecCheckDraft(draft));

{ Send order }
if(oecSendOrder(draft)) then
Print(*""'Sent successfully™)
else
Print("'Did not send");

{ Prepare other two drafts of 0CO }
draft = oecCreateDraft(*'Buy", 2, "Limit", oecCurrentPriceLastPrice() - 1, 0, ",

draft2 = oecCreateDraft(*'Buy", 2, "Stop', oecCurrentPriceLastPrice() + 1, 0, "*,

{ And send 0OCO }
if(oecSendOCO(draft, draft2)) then
Print ('OCO is sent");

draft3 = oecCreateDraft("Sell", 2, "Limit", oecCurrentPricelLastPrice() + 0.5, O,

{ And bracket }
if oecSendLinked2(draft3, draft, draft2) then
Print ("Bracket is sent");

if AB <> """ then begin
if ABSize > 0 then
draft = "Sell”
else begin
draft = "Buy";
ABSize = - ABSize;
end;
draft = oecCreateDraft(draft, ABSize, "Market', 0, 0, "None', "Test of AB
from TS");
{ Initialize Allocation Block structure before sending }
oeclInitializeAllocationBlock(™TS AB"™, '"LowAcctHighPrice', AB);
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if oecCheckDraft(draft) <> """ then

Print("Invalid AB order: ", oecCheckDraft(draft))
else
begin
if oecSendOrder(draft) then
Print(""AB order is sent')
else
Print(""AB order is not sent");
end;
{ Reset the using of allocation block }
oeclInitializeAllocationBlock(*"", ", "");
end;
end
else
Print("'OEC is not connected");
end
Help

There is a generated HTML file with short documentation on using the OEC API TradeStation function

located at http://www.openecry.com/traderstoolbox/autox.cfm.

Format of declaration:
1. Original OEC API hierarchy
2. Name of function without “oec” prefix
3. Line for copy-pasting to strategy code to import function
4. Implemented .NET code in OEC API terms.

Sample:

Client.Accounts.SelectAccount

SelectAccount
External: "OecFuncs.dll", void, '"oecSelectAccount", LPSTR{{Account}};
_Account = Client.Accounts[Account];

Client.Accounts.SelectAccountByID

SelectAccountByID

External: "OecFuncs.dll", void, "oecSelectAccountByID", int{{AccountliD}};
_Account = Client.Accounts[AccountlID];

Client.Accounts.SelectAccountBylIndex

SelectAccountBylIndex

External: "OecFuncs.dll', void, "oecSelectAccountBylndex",
int{{Accountindex}};

_Account = Client.Accounts.Values[Accountlndex];
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